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KPOCIHIVIAT®OPMHA KOMIT'IOTEPHA ITPOT'PAMA JIUIAA TIPOCTOI'O
PEIPECIMHOI'O AHAJII3Y JAHHUX

3a donomozoio mosu npoepamyeanns Java po3pobnena kpochiamgopmua Komn tomepHa npoepama 0s npocmoz0 pezpe-
CilIHO20 aHANI3Y OaHUX, AKA NPU QYHKYIOHYBAHHI BUKOPUCTNOBYE Pi3Hi MoOeli peepecii. Bona mae epagiunuil inmepgetic kopu-
CMy6aua i 3acmocogye OJis AHALIZYy MemooO HAMeHwux keaopamis. Ilpu ybomy 0l GU3HAUEHHS napamempie pecpeciiHol Mo-
Oeni i3 cucmemu AHIIHUX PIBHAHD, AKI (QOPMYIOMbC NPpU 00pOOYT CMAMUCMUYHUX OAHUX, UKOPUCMO8YEmbes Memoo I aycca.
Po3pobreruii 000amok 01 oyinKu AKOCMI MoOeli po3paxo8ye cepeonto NOMUIKY anpoxcumayii ma koeghiyienm oemepminayii
abo iHOexkc demepMiHayii, a 015 OYiHKU il 3HaUYwocmi 00uUCTIOE hakmuyre i Kpumuure 3Havenns F-xpumepiro @iwepa. [lpu
PO3DAXYHKY KpUMuuHo2o 3navenHs F-kpumepito @iuiepa npoepama eukopucmogye Qynkyito bema-posnooiny.

Knrouoei cnosa: peepecis,; ananiz oanux, memoo HAMEeHWUX K8aopamis.

Puc.: 8. bion.: 10.

AKTYaJIBHICTh THMHM JOCJIKEHHs. Y HaIll yac CIielianai3oBaHi KOMIT I0TepHI porpamu
IIMPOKO 3aCTOCOBYIOTHCS JUIsl @HANI3y CTAaTUCTUYHUX JAHUX.

Perpeciiinuii anaini3 € OAHUM 13 HalOLIBII TOMKUPEHUX CTATUCTUYHUX METOAIB. PerpeciitHuii
aHaJIi3 MiAPO3UISETHCS Ha OHO(pAaKTOpHUH (TpocTHii) Ta Gararodaktopuuii. OcoOiuBOCTI Mpo-
BEJICHHSI IPOCTOTO perpeciitHoro aHajizy CTaTUCTUYHUX JaHUX HaBeZeH1 B poboTax [1-4].

[Tpu nbomy po3poOKa KOMIT’ FOTEPHUX IPOTpam sl HPOCTOTO PerpeciiiHoro aHasizy AaHux,
K1 I11]] 4ac aHaji3y BUKOPHCTOBYIOTh Pi3HI MOJIEIII perpecii, € akTyaJIbHUM 3aBaIHHSIM.

ITocTanoBka nmpodiaemu. Perpeciiinuii aHami3 34e0UIbIIOT0 BUKOHYETHCS 33 JJOMTOMOTOIO
creniajJbHUX KOMEPIIMHUX KOMIT FOTEPHUX MPOrpam, ki MaroTh rpadiunuii inTepdeiic kopuc-
tyBauda (Graphical User Interface - GUI). Oanak ui nporpaMu B 06aratbox BUIAJIKaX >KOPCTKO
MpUB’s13aH1 A0 MEeBHOT mIar(Gopmu.

Bonnowac npu nmpoBesieHH1 perpeciiHoro aHamizy s BUOOpY ONTHMAaIbHOTO PIBHAHHS pe-
rpecii BU3HAYaroTh HOT0 SKICTh Ta 3HAYYLIICTH [3; 4].

[Tpu ubomy po3poOka kpocmiaarGopMHUX KOMIT roTepHUX nporpam i3 GUI, ski npu npoc-
TOMY perpeciiHoMy aHajli3i JaHuX BUKOPUCTOBYIOTh Pi3HI MOJIENi perpecii, a TAaKOX OLIHIOIOTh
1XHIO SIKICTh Ta 3HAYYIIICTh, € AKTYaJIbHOIO MPOOIEMOIO.

AHaJi3 ocTaHHIX AocaigxeHb i mydaikamiii. BinmosigHo no [3], mpocTta perpecis sBisie
co0010 MOJIeIb, /1€ CepeHE 3HAYCHHS Y, 3aJIeXKHOT (1[0 TTOSICHIOETHCS) 3MIHHOT ¥ PO3IIISIIAETHCS
aK (QyHKIIIS O/IHI€T He3aIeKHOT (TI0SCHIOI0YO01) 3MIHHOT X, TOOTO 1€ MOJIeNb (PIBHAHHS), IO Ma€
BUIVISL

Y, = f(x). (1)

ITpu mpocTomy perpeciiiHoMy aHalli3i epPeBaKHO BUKOPUCTOBYIOTH Taki MOJIEJIi perpecii:
Y, =Cy+C- X, (2)

Y, =Cy+C;- X+Cy- X2 +..4C,- X", 3)

Yr:C0+C1'll’lX, (4)

Yr:CO'XC]a (5)

Yr = CO 'eC].X ’ (6)

ne ¢, C;, Cy,y ..., C

, — MOCTIHHI KOe(IIIEHTH, n — CTYIIHb MOTIHOMA.

Bupasu (2)-(6) onucyoTh JiHiiHY, TOJIHOMIANbHY, Torapu(MiuHy, CTaTEUHY Ta EKCIIOHE-
HTHY perpecito BiIOBIIHO.

Jns Busnauenns C,, C;, C,, ..., C,, MO)KHAa BUKOPUCTOBYBATH METOJ HaWUMEHIIUX KBAJ-
patiB (MHK) [3; 4]. Onuc MHK 13 npukiagamMu KOMITIOTEpHUX TIPOrpam, siki HOro peasnizyroTh,
HaBeJIeHO B [5-7].
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OniHKy SIKOCTI PIBHSHHS perpecii 3MiiCHIOITH 3a JOMOMOIor0 KoedillieHTa AeTepMiHalii
(inmexcy metepminamii npu n > 1) R’ Ta cepemHboi MOMWIKY anpokcumanii ME [3; 4]. Bin-

(¥, - ¥,.)°
R2 =1- i=’é 5 (7)
S-vy
i=1
AM:iiQﬁﬁﬁJm(%L (8)
Ly i

e Y, — eKCIiepUMEHTANIbHI 3HAYEHHS ¥ TIpU X;, Y,; — 3HaueHHs QyHkuii (1) npu X;, ¥ — cepe-
JHe 1us Y, ¥,, ..., ¥,

SIkicTh Mojenm perpecii 3poctae, sKIIo 3HaueHHs R’ mparde 1o 1. Y Toil yac 3HaueHHs
ME <7 % TakoX CBIJUUTH MPO 33JOBUTLHUI BUOIp MOAENI 10 BUXIAHUX JaHMX [3].

Tum vacom, Ui OI[IHKK 3HAYYIIIOCTI MOJIENI perpecii A JaHUX 3 m Tap YUCe, 31CTaBIIs-
10Th (pakTuyHe 3HaueHHs F-kpurepito Pimepa F 1 KpuTHUHE F,, JUIS 33[]aHOTO PIBHS 3HAUYIIIO-
cTi «. SIkmo F Ounblue F,, MOJETbh Perpecii BU3HAETHCS 3HAUYILIOIO IS IIbOTO PIBHS 3HAYM-
MOCTI, iHaKIIe — He 3Hauymo0. Gaktuynuil F-kputepiil BU3HauatoTh y Takuii croci6 [3]:

RS m—k-1I
i-r?) K

Bennuuna £ B (9) xapakrepusye 4ucio CTyNEeHiB cBOOOAU f; Ui (pakTOpHOI CyMH KBaj-

F =

)

pariB, a (m—k—1)- 9MCII0 CTYIEHIB CBOOOAU f, IUIs 3aJMIIKOBOI CyMH KBajpariB [3].
Kputnuni 3HaueHHs F-kputepito Mo)KHa po3paxyBaTH 3a JIOTIOMOI'OI0 HEMOBHOI (yHKIT
OeTta-po3noaity, mo mMae Burisa [8; 9]:

1 ()= B(;’b)jta_l(l—t)b_ldt, (10)

ne Bipizok 0 < x< 1, Ha sKOMY BU3HAYa€eThes [, (a,b), a, b — ApaMeTpH,

B(a,b):j't“"(l—t)b‘ldt. (11)
0

ITpu 1ibOMy KpUTHYHE 3HAUEHHS F,, , JUIS PiBHS 3HAYUMOCTI « , IpU f; Ta f,, MOXKHA 3HANTH
3a I0TIOMOT 010 Bupasy [9]:

1{%%:1_“, (12)
A€ x Ma€ 3HAUYCHHS:
wo—Jifa (13)
f2 +f1Fa

BimzHaunmo TakoxK, 10 y HAlll Yac OJHIEI0 3 HAWOUIBII MOMYJISIPHUX MOB MPOTrpaMyBaHHS
€ Java. Bona kpocmiardopmua i Mae API, sikuit 703BOJIsIE CTBOPIOBATH MPOTPaMU JIJIsl CTaTUC-
TUYHOI 00poOKM MaHUX 13 rpadiuHuM iHTepdericoM KopucTyBaya.

OcTtanHiM yacoM Ha MOBI iporpamyBanHs Java po3po6iena nporpama ST Regression [10]
s perpeciiinoro ananizy 3 GUI. Lleit monaTok A1 OLIHKH SKOCTI MOJIENI PO3paxoBye cepe-
JTHIO TIOMUJIKY alpoKCUMaIlii Ta KoedilieHT aeTepMiHalii abo 1HIeKC AeTepMiHallii, a s oi-
HKH 11 3HaUymocTi oouucitoe paktuune 1 KpuTHuHe 3HadeHHs F-kpurepiro Dimepa.
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BujineHHs1 HeOCTiIXKeHUX YACTHH 3arajbHoi mpodJemu. [Iporpama ST Regression
Mae CyTTeBE OOMeKeHHs. BoHa MO)Ke BUKOHYBATH JIMIIIE TIOJIHOMIaTbHUIN aHAI3 JaHHX.

ITocTanoBka 3aBaaHHs. Y 1iif poOOTi Oyna mocrasieHa 3ajaya po3poOKH 3a J0IOMOI00
MOBH IIporpamMyBaHHs Java Kpocruiar()opMHOTo JOAATKa Il IPOCTOTO PErpeciiiHoro aHamizy
nanux 3 GUI, sxuii npu $yHKIIOHYBaHHI BUKOPHCTOBYE pi3HI Mojeni perpecii. Kpim toro,
MPEJCTABIISE Pe3yabTaT POOOTH B rpadiyHOMY Ta TAOIMYHOMY BUTJISL, @ TAKOXK OL[IHIOE K-
ICTh 1 3HAYMMICTh PIBHSHHS perpecii.

Bukiaaa ocHoBHOro marepiany. /lyis piteHHs moctaBieHoi 3a7a4i OyB cTBopeHuil Java-
noxatok DS Regression i3 rpadiuaum inTepdeiicom KopucTyBaya.

Ha nouatky po6oTH i3 mporpamoro BuOHpaacs HeoOXiJHa MO/ENb perpecii A aHamizy
naHux. Bubip 3xificHIOBaBCS MpH BKIIOYEHHI BiAnoBigHoro npanopus GUI, Ha3Ba sikoro 30i-
rajacst 3 HeoOXiTHUM piBHSHHIM perpecii. [ToTim 3a gonomororo mento «File» BuXiaHi AaHi
IUISL aHAJIi3y 3aBaHTaXyBalIucs 3 *.csv (aiiiiB 1 3anmoBHIOBaNu Tabnuiio «Datay.

3a HeoOXiJHOCTI MPH HATHUCKaHHI Ha KHOMKY «Input» psaku Tadbmuii «Data» Moriu 3amnoB-
HIOBaTHUCs a00 JOMOBHIOBATHCA JAHUMH MO X Ta Y , SIKI MONEPEIHbO PO3MIILAINUCS B MOJAX
BBOAY «X» 1 «Y or PVy (mons BBoay «X» Ta «Y or PV) BUKOpHUCTOBYBAIUCS 1 P MIPOTHO3Y-
BaHHI 3Hau€Hb Y, JJIS BIATOBIAHUX apTyMEHTIB X , SIKI BBOAMJIUCS KOPUCTYBAYEM).

Psinok, 1m0 BUIUISABCS, MOXKHA OyJI0 BUJTAJIIMTH 32 JooMOroro kHonku «Cut Row». KHormka
«Cleary 3acTocoByBaiacs sl BUAAJICHHS BCIX PAJKIB Y TAOIHUIAX J0AaTKA. Y TOM Yac CIUCOK,
1110 PO3KPHUBAETHCS, JO3BOJISIB YCTAHOBUTH CTYIIHb 7 JUIS MOJIHOMIaNbHOT Mozieni perpecii (3)
y Mexax Big 1 10 6.

Amnani3 nanux nporpamoro DS Regression 3xiiicHioBascst 3a gonomororo MHK. Ilpu pos-
paxyHkax piBHAHHA (3)-(6) monepeaHbO MPUBOIMINCS 10 JIHIMHOTO BUIJISLY. 3HAUYCHHS KOe-
¢iuientiB C,, C;, a TAKOXK MPH HEOOXIAHOCTI 1 C,, ..., C, , 3HAXOAUIIHUCS 13 CUCTEMH JIHIHHUX

PiBHSHB, AKi (hopMyBasucs npu 0OpoOIIi 1aHKX, 3a JOMIOMOroko Meroay [aycca.

Jlnist OLIHKM SIKOCT1 Mozieni perpecii gonarok DS Regression BU3HauaB CEpeHIO TOMUIIKY
anpokcuMaliii Ta koedilieHT aerepminanii (iHaeKC AeTepMiHaLii [yt piBHsSHHA (3) pu 7 > 1),
a JuId OLIHKM 3HAYYIIOCTI MOJIENII BUKOPUCTOBYBAaB KpUTUYHE 3HaueHHs F-kpurepiro Pimepa
npu ¢ =0,05.

3amyck 00poOKM TaHMX 3/11HCHIOBABCS IPU HaTHCKaHHI Ha KHONKY «Calculatey. [Ipu iibomy
nporpama Jjst o0paHoro piBHSIHHS perpecii po3paxoByBana koeQilieHTu f;, f>, Cy, C;, Ipu
HEOoOXiHOCTI C,, ..., C, , CEpEAHIO MOMIJIKY allpoOKCUMAIlil, a TAKOK 1HJIEKC JieTepMiHaii abo
a Takox moJsix BBoxy «ME, %» 1 «R”2», BiAMOBIIHO.

Taxox mporpama Juist apryMeHTy X , IO YBOJAWB KOPUCTYBad, BU3Havaja MPOrHO30BaHY
BenuunHy PV Moneni, sika ikaBuiIa KOpUCTyBaya, 1 momimiania ii B mosue BBoAy «Y or PVy.

Kpim Toro, mis mopmeni perpecii, 0 BHUKOPUCTOBYBajacsi MpH OOpoOIl AaHUX, MPH
a = 0,05 po3paxoByBaiucs Ta 31CTaBIsIINCS (aKkTUUHE 1 KpUTHUHE 3HaueHHs F-kpurepito Di-
mepa. Pe3ynbrat 11poro 3ictaBieHHs 3’ sBisBcs B ol BBoxy «F ? Foos». Y Toii yac 3HaueHHs
Y, Ta 3aJMILIKIB perpecii, iki BU3HAYaIUCs MPOrpaMoro AJs BCiX X 3 BUX1THOT0 HAOOpy JaHUX,

po3Mimanucs B Tabnuii «Datay, a BUXigHI AaHl MO Y 1 po3paxoBaHa IO HHUX 3aJICKHICTh
Y. = f(X) BigoOpaxanucs B rpadiyHOMY BUTIISAI Ha MaHEN1 101aTKa.

KopuctyBau nporpamu 3a gonomoror MeHro «Filey MaB MOXIIUBICTh 30€pert 3HAYCHHS
napameTpiB perpeciiinoi mojeni y ¢aitnax gopmary *.csv. BogHodac 3a 70momMoror MeHIO
«Tuning» npu HEOOX1THOCTI HACTPOIOBAIUCS 00JacTh BiAoOpaxkeHHS Tpadika, a Mpu BUKOPHU-
ctanHi MeHI0 «Help» Oyna moctymnHa iHdopmallist Ipo CTBOPEHUM JOJATOK Ta OCOOIMBOCTAX
Horo po6oTu.

Hamu Oyno nposeneHe tectyBaHHs Jojatka DS Regression i mopiBHSHHS pe3yJbTaTiB
iioro po6oTu 3 pesynpTaramu 1moodyaoBu perpecii TabaumunuM mpouecopom LibreOffice Calc
pu 00poOIIi THX caMUX HAOOPIB JaHUX.
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Jns TecryBanus nonatka DS Regression Oyna gonaTkoBo po3pobiena Java-porpama, mo
reHepyBaJia BUMIAJKOBI 3HAUEHHS 3aJIeKHOI 3MIHHOT Y JUIsl AMCKPETHUX 3HAYCHb HE3aJICKHOI
3MIHHOI X , siKi 3MiHIOBanucs B iHnTepBaii Bix 0,1 mo 1,1 i3 kpokowm 0,1, 1 30epirana ix ¢aiinax
dbopmarty *.csv.

ITpu npomy naHi mo ¥ ¢GopMyBaiucCs B LUK 3a JJOMIOMOT'O0 BUPA3iB:

Y, =cy+c;-X; +0.5- Mathrandom(), (14)
Y, =(co +¢; - InX;)-(0.95 +0.1- Math.random()), (15)
Y =cyp X! ~(0495 + 041~Math4random()), (16)
Y, =¢ €1 i -(0. 95+0.1 -Math.random()) R (17)

1€ Math.random() — peaizallisi FreHepaTopa BUIAJKOBUX YHCENl Ha MOBI IporpamyBaHHA Java, ¢,
¢; —TOCTIHH1 Koe(ilieHTH, skl Oynu piBHi 1 1 2, BIANOBIIHO.

®opmyna (14) BUKOpUCTOBYBaJIacsl IpU reHepallii 3HaueHb Y 13 METOI0 TeCTyBaHHS Ipo-
rpaMu IpH aHajli31 JaHUX Ha OCHOBI JIHIMHOT Ta MOMIHOMIaNBbHOI MOZETi perpecii, hopmyiu
(15)-(17) — norapumiuHOi, CTAaT€YHOT 1 €KCIIOHEHTHOI, BiJTIOB1IHO.

Ha puc. 1, 3, 5, 7 3006pakeHi BikHa po3po0IeHOro go1aTKa mpu podoTi B TECTOBOMY PEXUMI
IIPU aHamli3l JaHUX HAa OCHOBI CTaTEYHOI, MMOJIIHOMIAJIbHOI, €KCIIOHEHTHOI Ta JorapupmidHoi
MoJielli perpecii, BiAMOBIAHO.

Ha puc. 2, 4, 6, 8 300paxkena modyaosa 3a nonomoroto LibreOffice Calc craTeunoi, mosi-
HOMIaJIbHOI, €KCTIOHEHTHOI Ta Jorapu(Mi4HO1 perpecii BiAIOBITHO.

E DS_Regression |Z| |‘_E||._§?|

File  Tuning Help

REGRESSION EQUATIONS FOR PROCESSING STATISTICS

2 .
T =Cyx"1 TG ¥ E X TN 4, AT O
Ty = Cyexp(CyX} [ Tp= Cy+Cylnx [ Tr=Ch+CyX 0O
Graph Y, = £ (X) ¥ YorPV  F 7 Fags ME, % RA2
1,5 111 | pv=1,240 [3ma725512| 2008 50399?5512:
L e 1 e 1 | | x 1
Input “ Cut Rowe “ Clear J no|1 s|f Cacuate |
Data Walues oy
. i F | v | i | GYeil m| T
1| 010 |00 | 0010 | oo00f 1 1
|
& 2 | o20 D,D4D.| 0,029 | o,001| 2 g

3 | 0,20 0086 | 0089 | 0003 Crefficients Cn,
s 4 | 0,40 50,158 0,159 | -o,001 n'l "(jn
5 | 050 | 0241 | 0,249 | -0,008| 0 |1,0048582082319455
& | 080 :0,360. 0,260 | 0,000 T{ 2,011421459410966
7 | o7a ;0,498' 0490 | o008
ol 8 | _D,EID 50,545 _6,541 0,005_
0 0.2 04 0,6 0.8 1 12|90 | goo |o791 | me13 | -o;022
|

2 10 | 1,00 | 1,027 | L005 | 0,022

I I
ll| 1,10 | 1,247 | 1,217 0,030

Puc. 1. Bixno npoepamu DS Regression nio yac ananizy oanux
Ha 0CHO8I cmameuHoi mooeni pecpecii
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& B [c] o | E | F | G H I | ] |
1 |1 o0
K L5
3 | 0,3 0086
4 | 04 0158
5 | 5 @241
e | 0E 036 ‘r’;: 1 HIBRE2B823195 X2 0114314584 10397
— 0.7 0406 1 R =(999766117111717
& | 4,8 0646
9 |09 8791
S L T 1 =5
1| 1,1 1,247
_12 ] {5
13
1% ]
_15 |
_16 |
17 &
_18 | i 1,2
_19 |
20 X
21

Puc. 2. [lo6yoosea cmameunoi peepecii 3a donomoeoro LibreOlffice Calc

" DS_Rearession

CEX

File Tuning Help

REGRESSION EQUATIONS FOR PROCESSING STATISTICS

<o c ot 2 n
Yr=1CpX™1 0O Tr=Cp+ X+ CoX™+. ..+ 0 X
Tp = Cpexp(CyX) [ Ye=Cy+Cylnx [ Te=Ch+CiX O
Graph Y, = £ (X) ¥ YorP¥  F ? Fous ME, % Re2
1,11 | Pv=3,488 1115,94:»5,15! 1,579 EDJ99433131|
: [ Input H Cut Rowy J[ Clear J no6 w | Calculate
Data Yalues fy
2 il ® | W | Y |[¥-Yes| m| Tiu
3 1| 010 | 1442 | 1441 | ooo1 1 | &
| |
. 2 | o200 | 1895 | 1,706 | o100 2| 4
oy j= :
2 | 030 ;1,91? 1892 | 0035  Cosficents Cr
4 | 040 | 1,954 | 2006 | 0,052 n| B
i 1 1
< 5 | G50 | 2172 | 2,148 | D0z4] D | 1,155327273969951
& | 060 | 2358 | 2351 | 0007 1 j2,26?3499156038?48
7 | 070 | 2640 | 2616 | 0033 2 511500340398213043
o 8 | 080 2799 | 26807 | 009 3 | -688462022366366
0 0,2 0,4 0,6 0,8 1 12 g ‘ 0,90 | 3,225 | 3,130 | 0,095 4 i139,855?69801??91
%z 10| 1,00 l 3246 | 3288 | 0,042 5 |-119,06638540605608
|
11| 1,10 | 3466 | 3459 | 0,007 & :36,421568?3609391

Puc. 3. Bixno npoepamu DS Regression nio yac ananizy oanux
HA OCHOBI NOJITHOMIAIbHOT MOOei peepecii
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a1 B || D | E F | G | H | I | ] |
[ T L A e .
~z | 2 1,696 4
3 | 03 1,017
4 | 04 1,054
5 |15 2172
"6 | 0.6 2,358 3
7 | 07 2,541
8 | 18 2799
_9 09 a2
| 1 3248 =
it | 1,1 3466
12 |
13 1 ¥r= 364216 X5 - 1190166 X5 + 139,856 X* - 68,8462 X% + 11,5003 X2 + 2,26735 X
14 ] + 115533
_15 | R? = {1,39433 1310147508
16 |
LG i
iz i {2 14 {5 .3 1 1.2
20 | :
_a |

Puc. 4. [lo6yooea noninomianvhoi peepecii 3a oonomozoro LibreOffice Calc

2, DS_Regression
File Tuning Help

REGRESSICON EQUATICONS FOR PROCESSING STATISTICS

L=GXxS [ Te=Cp+ CX +CoX2 4.0t Cpx” O
Ty = CpexpiCqX) Tp=Cy+Cylnx [ r=Cy+ X [
Graph Y, = f (X) X YorPd  F ? Fops  ME % 2
1 7 1,11 ! Fy=0,163 !3955>5,12 | 302 | 0,99773501

[ Input H Cut Rowe J[ Clear

7.5 Data
' i % | Y | Ve [YiWei| m| T
1 0,10 | 1,235 | 1,220 0,015) 1 | 1
o ﬂ 0,20 :1,482 1,400 | 0,008 2: g
3 | 030 1898 1819 | 0,079 Cosfficients i
4 | 040 | 216 | 2221 | 0061 n| o
25 i| 0,50 E, 2608 | 2,712 -0,1044 O ; 0,999636668833691
5] 0e0 | 3398 | 3,311 0,087 1 | 1,985985181765156
070 | 3,914 | 4042 | 0128 '

|
. [
[ L =k | -

E | 8| 080 5009 | 4935 | 0le4
0,0 0,2 04 0,6 0,8 1,0 12 o ‘ 090 | 5753 | 6026 | 0,273

|

|

|

|

1

7471 | 7357 | @114

A 10| 1,00

11| 110

9,189 | 8,982 0,207

Puc. 5. Bixno npoepamu DS Regression nio yac ananizy oanux
HA OCHOBI eKCNOHEeHMHOI MoOeli peepecii
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s B | c| o | E | F | G H I | ] |
1 | 01 1,23 0
"z | 02 1482
3 | 03 1,898
4 |04 218 Y;:D,QQQESEEEEESSEBQBW[1,995985181?8515}{]
5 | 05 2,608 75 R2 = (199773507 842426
& | 0F 3,398
7| 87 3914
& | 0,8 5009
9 |89 5753 g
o | 1 747+
11 | 1,1 9,189
_12 |
| Lo 2,5
_14 | ’
15
_1& |
_17 it
18 1] 4,2 4 6 .8 1 1.2
19 |
_20 |
21

Puc. 6. I[lo6yoosa excnonenmmnoi peepecii 3a donomoeoro LibreOlffice Calc

| DS_Regression |Zl|‘_ﬁl.._§|
File Tuning Help
REGRESSION EQUATICONS FOR PROCESSING STATISTICS
v, = xC1 ¥, =0 +C X+ Co¥o 4+, . 40 %% O
- 0 El = 0 1 o — .
Yr=CDexp{61X} C Y= CD+CllnX = CD+ Cq% &l
Graph Y, =f (x) ¥ Y af PY F ? Fags ME, %% R&2
2 1 14T ! Fy=1,392 ! 1076=5,12 I F67,007 EDJQQI?DSDCI|
- ..-f‘/‘ [ Inpurt H Cut Row J[ Clear ] n - Calculate |
1
Diata
" - il & | 0w | Y W] m|
1| 0,10 |-3,232 |-3,192 | 0,040 1| 1
| |
2 | 0,20 |-1,796 |-1872 | @076 2| 9
o —l ' -
3 | 030 -1,072 | -1,099 | 0,027 Coefficients Cp,
4 4 | 0,40 !-DJ545 0,551 | 0,005 ﬁ'] "c"n
L. | 0,50 !-0,051 -0,126 | 0,075 O 51,193688494402?254
i [ I
i 6 | 060 |-0,003 | 0,221 | 0224 1 1,9045010188540147
7 | 0,70 in,4?3' 0,514 | 0,041
- 8 | 080 065 | 0769 | 0,115
0 0,2 0.4 0,6 0.8 1 12| o ‘ 0,90 | 1,280 | 0,993 0,296
b4 |
o | 1,00 | 1,176 | 1,194 | -O,018
L1
11 | 1,10 | 1355 | 1875 -0,042

Puc. 7. Bixno npoepamu DS Regression nio yac ananizy oanux
Ha 0CHOBI 102apughmiunoi mooeiui peepecii
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al B8 [c[ o | E F | & [ w [ 1 [ 3 ]
1| 01 3232
"z | 02 1,79

T3 | 03 1072

"4 | 04 0546 L Yr = 1,90450101865402 InfX) + 1,10368649440273
5 | 05 0,050 RE = (1,001 FI5(02621004

_6 |
7]
_8 |
_o |

* __*--——"F*

1.6 -0,043
4.7 0473 { *
4.8 {0,664 { .2 4. .6 .4 1 1,2

09 1.280 x
| 1 1176 1 /
1| 11 1333

Wr

Puc. 8. I[lo6yooea nocapughmiunoi peepecii 3a oonomozoro LibreOffice Calc

SIk 3’sicyBanocs B pe3yJibTaTi TECTYBaHHS IIPOrpaMH, Ma€e MiCLe 3310BIbHA 3ro/ia pe3yJib-
TaTiB aHAJI3y TUX caMUX HaOopiB JaHuX aoxaTkoM DS Regression i TaONUYHUM MIPOLIECOPOM
LibreOffice Calc nmpu BUkopucTaHHI OJHAKOBUX MOJIeNEl perpecii.

BucHoBku. Takum unHOM, Yy 11iif po0OoTi OyB po3pobiaeHuit kpocruiatdopmumii Java-gona-
Tok DS Regression [uis mpoCTOro perpeciifHoro aHaiizy AaHuX, SKAN NpU (YHKLIOHYBaHHI
BUKOPUCTOBYE pi3HI Mojieini perpecii. KoM’ totepHa nporpama mae rpadiunuii intepdeiic ko-
puCTyBaua.

VY mporeci aHanizy JaHUX BOHAa BUKOPUCTOBYE METOJ HaliMeHIIMX KBajpaTiB. Kpim Toro,
NPEJCTaBIsIE PEe3yIbTaTH aHaNI3y B rpadiuHOMy Ta TaOIMYHOMY BHIJISJI, a TAKOXK BH3HAYae
napameTpH, Kl HeoOXIiJJHI JUIs OLIHKU SIKOCTI Ta 3HAYYLIOCTI PIBHSAHHS perpecii: KoeilieHT
JeTepMiHalii abo 1HAEKC JeTepMiHallii, CepeaHI0 OMIIIKY anpoKcuMallii, (pakTHUHE 1 KpUTH-
yHe 3Ha4yeHHs F-kputepito Dimepa.

Hanani nepenbauaetbcs MojepHizyBaTH aoaaTtok DS Regression, 30kpeMa, mpu mpoBe-
JICHHI aHaJli3y AaHUX 3a0€3MeYUTH MOXKJIMBICTh MOPIBHIHHA (paKTUYHOTO 3HaueHHs F-kpute-
Pit0 1 KPUTUYHOTO MIPU PI3HUX PIBHSAX 3HAUYLIOCTI.
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UDC 004.42: 303.724.32
Sergei Tochilin, Vadim Rybin

CROSS-PLATFORM COMPUTER SOFTWARE
FOR SIMPLE REGRESSION DATA ANALYSIS

Currently, specialized computer programs are widely used to analyze statistical data. At the same time, development of
computer programs for regression data analysis is an urgent task.

Regression analysis is usually performed using special commercial computer programs that have a graphical user inter-
face (GUI) and in many cases are rigidly tied to a specific platform.

Currently, one of the most popular programming languages is Java. It is a cross-platform and has an API that is freely
distributed and allows to create programs for statistical processing of experimental data with a graphical user interface.

Recently, a cross-platform program ST Regression for regression analysis with GUI has been developed in the Java
programming language.

The ST Regression program has a significant limitation. It can only perform polynomial data analysis.

The task is to develop a Java GUI application for simple regression data analysis that uses different regression models to
function. In addition, it presents the results of work in graphical and tabular form, and also assesses the quality and significance
of the regression equation.

The features of functioning and the graphical user interface of a Java application that solves the problem are described.
Examples of its use are given.

Using the Java programming language, a cross-platform computer program for simple regression analysis of data, which
uses various regression models in operation has been developed. It has a graphical user interface and uses the least squares
method for analysis. At the same time, the Gaussian method is used to determine the parameters of the regression model from
a system of linear equations that are formed during processing of statistical data. The developed application for assessing the
quality of the model calculates the average approximation error and the coefficient of determination or the index of determi-
nation, and to assess its significance calculates the actual and critical values of the Fischer F-criterion. When calculating the
critical value of Fischer's F-criterion, the program uses the beta distribution function.

Keywords: regression; data analysis; least squares method.

Fig.: 8 References: 10.
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